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1.48%%

Geographic Imager 5.0 &5 A T Adobe Photoshop K Avenza | Bfdifd: .

Geographic Imager ¥E Adobe Photoshop ZEME—i#g, BIIFES V2 /H K Adobe Photoshop ¥AEE RIS BT OIE . YmtE
A TR SR T A G2 AR K ab B . Geographic Imager AT LA 7% A1 A AL 55 26 SRR M 185 F 52, JFEL
[FIFFH Adobe Photoshop %-1+4N5 K 1 T B AN AE Sk Xt 8244 3k 4T Ab T,

Geographic Imager Hi Adobe Photoshop fj— RF|HIFE A (0] T HLH AR, X4 T R 7E 2 A fOA Bl E I i v n e SR R
T EMWE st ST ki, Geographic Imager tH7& MAPublisher #l1 Adobe Illustrator &3 HIEC &AL,

IR B 2 5% Adobe Photoshop FLEEAZE, B/D%F GIS MR ARFIME & A AN T ##. 28 T f# Adobe Photoshop Ff siAH K[
HZ{5E, FILLZ 5 Adobe Photoshop 48w . #8 T fi# Geographic Imager TR T HMIE Z(EE, S HAvenza %
467 — Projections Guide (iZ#8F1E Help and Tutorial Data CHF3EH).

1.1 IDEENR

LT RIZEULE] T Geographic Imager #fFHIZEATIRE
I/ R T REH

AT IR RS, Geographic Imager R H Z)IRJ GIS Mit% % Xt HARAE B 52 LS U MF. 2% E B2 BRTE
Geographic Imager [Hi#R . *4{#H] Adobe Photoshop A% & [IRAE iy & KIRATE— AN HEFRFAZIN, Geographic Imager 2% F 34
BN IS B E GeoTTFF Sk XU{E .. Geographic Imager SZRFATH I Adobe Photoshop s 5 Hid% N, M
Adobe Photoshop HJE EH30 PSD #1 Adobe Acrobat PDF #xl. B&T GeoTIFF, KB4tk Nt — M &H 304 (i
world ) o —SEEAG M AN SR A 23 Geographic Tmager [A1%, EANRELE Adobe Photoshop BLFTJFM, 4 MrSID,
JPG2000 H1 DEMs . # —2ekg sUANBEAF U E JE R IR 2R, AL AU L3 — A& 3, 40 GeoTIFF. 48T M50 21X 7M1 751555

Bl 1AL
bt 2233 @

Geographic Imager ff T GeoTransform $iAR, —MIRMAMIFAZE RSN, |2 LIFZ AL TR EE AL bR RS
#, BEWSTE Adobe Photoshop HXTEAAG AT H . 4, Geographic Imager IB37HFE & . T MEHE LX TN
KSR 2 A G e ¥ .

HEBBSFE AT JLTH IE

Geographic Imager fEVLIHIVRIN T — M FLARFRFE N, 1 Adobe Photoshop AAEHLEAE M RS, EAEEEAS Adobe Photoshop
FEAE AL B FE TR AR AT AR AR B 5 — H A B R, XA M B R RS R MO s 7T CASE 07 JE M KR IE A s EE 22545 2
fRE T k. HiKiF, Geographic Imager Ry LRI B I INEAE, WMBYIMEBE R ERG RN, I HRES G LAY



REAEAL, HPIEHZEFEE . Geographic Tmager REX AHTHEL S H I EA MBS, Refi ] QA= H] OB B R
B RHBARFR AR R AR AT T U IE . A8 TR SE 2 X T I N BT 2 I RIS %

pax ]
Geographic Imager T LA H 3 2 [AIFAZ 0B/ B Z A Mg, RN EGN/ NG BRBHMESEEE . XSGR 75
FiR%Z, MUREFEATERE. BT HELSXHTEHMARESRMEDIE.

.3

Geographic Tmager fig H 245 2 MELAR G I 4 G B ERIRE, RN EH RIS LRI 2 HE R . BER 24
A FAR S AL OTE S M RAR . AT S 22 X THD 1A 9 7T 2 [ S AR B R

- 0’)]

R E S R VI L S B S AR AT B D) . XA T RARSEA, W] DA ORI Y R B R IR . A8 T W BE 22 X 7 THT 14
RESTEARFA S

I

AR RN TR AR SRR 20, ISOEIRE TR/ ERAE . JBUE T, DEM 2E. ik, T
523X T7 I (A S I A R R A DI REFT TR AR

DEM 5% (DEM schema)

DEM schema NIES: MM LR MR AL T —MIRA RIS SAF#T775 . DEM Hdfs 7 BT 5 (AL 3, XA REEAT AT AL s R
JH DEM 54 870 UL AR B A ULRCR S5 5 0 (07 SRR AT 8 Xl Bl #0775, 734k, DEM schema I&37#f
PR ULR 2 AR (07 S 60 DEM SR OB IR . A8 1 3 SE 21X T7 TR A N 515 S (14T IF DEM. schema.

HWifE#E (Terrain Shader)

Terrain Shader T E.AE7E Adobe Photoshop LY % ve &5 S AN E (Bt B sh 2 o7 FH BB M AR Y |, 180T DL A 5 N — > DEM
Bym H BARE S AR vl P o AR BRSO, B S R 5 IR AL B A R IA B AR AR RS AR . AT RAB 2
& S B AdtoshOp CA MRS S NHEB G E .. A8 T i 21X 7T N 598 Z 1 B 25 DEM
schma.

B

Geographic Imager [f] Channel Management W] DLY$ 23 BUsZ B 00 BU g T B4, B HARAIFERIRE ORGSR EE A%,
M TEZ X TR A RIS S B e,

BT A

P11 Geographic Imager iy 4 #1584 BRI A TR ME A A

s a] DU FA B B 2 A TR E SR S2 AE 55 At AL BEAE N . Geographic Imager JavaScript ThEESE4n] LA B ZE &S 5.
TR 2 X DT N A5 27 Geographic Imager HaIKHLALE.
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Geographic Imager REf% S H Adobe Photoshop BT CRFIISAZ SCAFAE . HJIE— My B S H AR — DA I 5 5%
A% FRET (U0 JPEG) , Geographic Imager <G — MM S5 344 (110 World ST .

Geographic Imager 1] LA S 7 W EE S5 B SCF#% 30, 40: GeoTIFF, BigTIFF, DEM TIFF, Geospatial PDF,
ERDAS IMAGINE Raster, ECW, MrSID, AINITF. 87 f#¥ LT LM GKRNIES RS H 4.

S PDF Maps
{8 F Export to PDF Maps A= sl B 3 H B2 6 H FA% %] PDF Maps Bi)JE (&% 2E7E i0S, Android A Windows Phone k-

[] PDF Maps B AT LW — AN HEREE) o SRR RIh BRI R, MTHEZXTHNARES RS
H PDF Maps.



2. G NHTE
2.1 BIGSNTISEIR

BHBEAN
TH— S A 4 BRTE Adobe Photoshop BT HAEEH B RGN T X —FE.
1. IR IEIER %35 T Geographic Imager.

2. f£ Adobe Photoshop H, fiiiik# File > Open. FfifkF\Tutorial Data\Americas 433 H [EIFTFTIF Americas 1. tif

1 Americas_4. tif,

@ v A | « Tutorial Data » Americas

Organize v New folder

¢ Favorites
#@& OneDrive

18 This PC

Americas_1.tif Americas_2.tif Americas_3.tif

ﬁ Network L

Americas_4_refer Americas_mosaic
encetfw tif

File name: |*Americas_4.if" "Americas_1tif v | All Formats (*)

["1Image Sequence I Open | I

IR Americas 4. tif R TS IRE I HAT I Geographic Imager MM . WIS VEA B RZEM, ik Window >

Extensions > Geographic Imager.



@ ERBFABERD =

Reference File:  Specify...

ode: A -
Image Mode: N/A Angle: N/A

| ®

Americas 4. tif WAHMMERSHHERE. R, BTG ESHE BN LR RS .

—NSE LA EMREBLE . BN BRKDNRGTE A RAPME R BN EERMEGEEE. BTk, &
FLeh Americas 4 CRATRE— NS H A
3. 1F Americas 4. tif XA A YFTEIRIRSHIEN T, 7E Geographic Imager MR H A Reference file J5TiM Specify.

4. %% Americas_4 reference. tfw I 5 Open.

P | « Tutorial Data » Americas

Organize v New folder

¢ Favorites

7@ OneDrive @ . LN
. o,
W b Americas_2.tif Americas_3.tif Americas_4.tif

Americas_1.tif

ﬁ Network . L _

>

Americas_4_refer Americas_mosaic
encetfw if

File name: | Americas_4_reference.tfw v l IAII supported formats (*.tfw *ti v I

| Open || Cancel ]




%52 M Americas_4 reference. tfw (World 2% 1) #ifE Geographic Imager MIAREAIH K T . 7E General Fl Corners ik

BiRE, MERT ERERSHEEE, UEPBGIEE. GE KDL LM T MR,

B

@ EHEEELABRERB =
Reference File: Americas_4_reference thwe
Coord Systam: Specify...
Mode: Standard
Image Mode: RGB Color | 8 Angle: 0 °
Genersl Corners DEM Survey Ruler
Geodetic format: Decimal Degrees
Image Sze: 600 x 457 px
Image Extents: 38,417 x 25.250
Geodetic Extents:
Pixel Sze: 0.054 x 0.064
=

TR FMARIRE MR RS
5. PRIEFIREERGONITIPRE, Tl 1Al
HE— MBI RR

U AR A AR RGE B B, ATty world SUAFERERAH ELE AT ALK RS N T AR, &
i AR E — N AR R S

HHTH Americas 4. tif currently A TR EAIR RGN . BEIZLL T DPR N ESGER Anericas 1. tif —FERIAAIR RS,

1. 7£ Americas 4. tif AT EIFIRSHIEM T, S Geographic Imager A [¥) Coordinate System 3T N

Specify k. @

Specify Coordinate System
Coordinate System: OK
[No Coordinate System Specified] © & “B‘* TCA}
[[]sameas: Americas_1.tif (WGS 84) -

AT LTI LR PRI TT 2 h B — RioR 45 IS SCRFRTE — MR R S8 AR R G0 HL IR — R A AR R L Bl ELHGE R CAT T

MG R G 5, MARER RS 8U  Ak #%

2. #E Specify Coordinate System XfiFHEH, rfiidi[No Coordinate System Specified] #%#%.



3. 1F Select Coordinate System XTiGEHER, FEJF Coordinate Systems > Geodetic > World Hik, fEMKRZR LG5I Hik$E W6S
84 Jf H A5 OK.

D ce:  C:\Program Files\s ) hic Imager \Data Source Files\geodata.xml
Custom Data:  C:\ProgramData\Avenza\Geographic Imager\customsystems. xml

Folder Ao
H- Africa

- Antarctica

H- Asia

- Europe

- Misc EPSG

t- North America
t- Oceania

Othe'

Display Name “  Name Horizontal Daturr Point Style Units ~ Env #
NSWC 9Z-2

NSWC 9Z-2 NSWC 9Z-2 Degree Wor
P P p Ze.. P p Ze... Degree Wor
PZ-90 PZ-90 Parametrop Ze... Degree Wor
Unknown datu... Unknown datu... GRS 80 Degree Not
Unknown datu... Unknown datu... Naval Weapons... Degree Not
Unspecified dat.. Unspecified dat... Not specified (b... Degree Not
WGS 66 WGS 66 WGS 1966 Degree Wor
WGS 66 WGS 66 WGS 1966 Degree Wor
~ Outdated (Deprecated) WGS 72 WGS 1972 Degree Wor
(- South America WGS 197. Degree Wor
~ World WGS 8 / 84

‘Projected

[+] ® [+] = 7/[@] [0

Ze...

P

BDDHDHBHBBDHBE &

4. 1F Specify Coordinate System XfifHAHEH i 0K,

Coordinate System: IIJ
s

[] same as: Americas_l. tif (WGS 349) v

B, Bl LUdiH Same as &I, KA Americas 1. tif #/& WGS 84 ALFRr R %G

Coordinate System:

WGS 84

Same as: INnericas_i.ﬁf(WGS 84)

XK, Bteh Americas 4. tif ¥BIE T WGS 84 PR RFE. ZALKR RSN EHFIN7E Geographic Imager THIAR 158 BT Box ok
7.



@ HEBEFEFABFRRB =

Reference File: Americas_4_reference thn

Coord System:  WGS 84

Mode: Standard

Image Mode: RGB Color | 8 Angle: 0°

‘General Cornars DEM Survey Ruler

Image Size: 600 x 457 px

Image Extents: 3841685667 x 22,25000000 ©
Geodetic Extents: 38.41666867 x 23,25000000 ©
Pixel Size: 0.08402778 x 0.06400438 ©

5. PRIFIXESLABONITIPIRG, FlMEREL MR,
AAHR R G

HABR R G RN — A B S (0 FUR AR B R — DAL FR R A T EXANEIE, ZHARHEMNGS 84 A
¥R RS T British National Grid A4 &%

1 7€ Americas 4. tif 53R4T HUEIREG NI N, £ Geographic Imager | i Transform 1%,

Destination Coordinate System Jransform

Destination: WGS 84
[] same as: Select Document -
Datum shift: [No Datum Shift Required]

Pixel Options
Pixel Size: S ( J | p.0s400438
Pixel Di * Preserve existing

Advanced options

Layers: Leave intact v Trim transparent edges
Resampling: [Nea’estNeid'lbor {preserve hard edges)
Precision: INormaI ipwidth: so < pixels

2. #E Transform XfiHHE, A7 WGS 84 #EHE Rkt — N AR HARALIE R4
IXERTEE — MEALFR R B RA—FEN . HERAFR RGO AR 2 TR AR R S

3. BJF Coordinate Systems > Projected > North America > United States H3%, fEARIR %% B i%F% United States:

Lambert Conformal Conic, meter, i OK.



Datasource: C:\Program Files\Avenza\Geographic Imager\Data Source Files\geodata. xml
Custom Data:  C:\ProgramData\Avenza\Geographic Imager\customsystems. xml

Folder ] Display Name “  Name Geodetic
= North America NADS3 / Great Lakes Albers NADS3 / Great ... NAD83(1986)
- Canada NADS3 / Great Lakes and St Lawrence Albers NADS83 / Great ... NAD83(1986)
Caribbean United States: Albers Equal Area, meter United States: A... NAD27

- Greenland United States: Lambert Conformal Conic, meter United States: L...

 Guatemala ) US National Atlas Equal Area US National Atl... Unspecified daf

+ Mexico
United States
t- Oceania
H- Other
- Outdated (Deprecated)
H- South America
- UTM

[+] ® [+] = 7 @@

R IE T T B BAR bR RS OB, 7R #2 Geographic Imager 23 H 3Nk — MG IE M A E ML
. WHRILEMET SN, i Specify &4, #TJF Specify Datum Shift XPIEHEH HiEFF 7R M AAE, 8 T Ml sE 2 0 T2k
w5 Ui BH 1 2 %) Geographic Imager F 4855 .

Destination Coordinate System

Destination: United States: Lambert Conformal Conic, meter
[} sameas: Select Document

Datum shift: NAD27 to 34 rev

Pixel Options

Pixel Size: | 7077.28950515

Pixel Dimensions: Keep pixels square
Advanced
Layers: Leave intact v Trim transparent edges

Resampling: lNea’estNeigbor(preeervehardedges) "l
Precision: | Normal v | Stripwidth: 50 % pixels

O, BERARE 7077, 28950515 K. ZAREA/NT LIRS 18 2 AT 10K . IXRETEA
R U TR/, BONE MR ERE T —AHIER T, TR E, RATERITA/AME
B IR KN .

4. s Transform %4



I Americas_4.if @ 100% (Layer 0, RGB/8) * =[O
L2 [10
ﬂ

4

RO VIR 3Ol Ao
i L !‘Sﬂmd’}!ﬂd%\
'C’JQL’!DL’JGQQC}DL’JCJGQC}DC)CJ
DDO']')DDDD']')DDDOBDD
| | DDDEE’)DDE}

'l S 'lu'l
o

W

ol

\’JOBE}C}E]G&]E}E}E}E‘I
L E N m
‘AR s En N
@DTD')DDDC]'lDEI

CJDC]&_

7,077.290 x 7,077.230 m

e e e el
mommmm
xr)ClE.\ﬂﬂOD
C)El&'l{.!ﬁl

lDfﬂS
i

|

|

|

||
o

|
T EE N R EEEEEEEE NS EE

{34’.’1{.3{.3CljDCJCJGCJO'}DCJCJQCJDOC’J{.’JQC}C}DC)QG}!

& |

XBE, AR R T Lambert Conformal Conic HEEARAR R4,
5. mifi Americas_1. tif U BB BB IRES, Rl Geographic Imager MHIHR B/ Transform $44H.
TR _E SRR A WGS84 AhAR R4t . St ] I H L3 Lambert Conformal Conic BUALARRL T -
6. fidi Same As EXEHEIF BN T Hi5 % Bk Americas 4. tif (United States:Lambert Conformal Conic, meter) .

7. FEHE RN 1EHE B )5 i Update pixel dimensions to match the selected document.



Destination Coordinate System

Destination: Urited States: Lambert Conformal Conic, meter

Same as: | Americas_4.tif (United States: Lambert Conformal Conic, meter) v |
Datum shift: NAD27-ALEUTIAN to WGS84 (rev)

Pixel Options

Pixel Size: | 7077.28950515

Pixel Dimensions: User specified
Advanced options
Layers: Leave intact v ! Trim transparent edges

Resampling: INeaestNeigbor(peservehadedgm)
Precision: | Normal

8. Aty Transform #%3H..

o E aaasaaassaasaaaa
HEEEEEEEE HEEEEE
T
HEEEEEEEEEEEEEEE NN
NN NN EEEEEEEEEEEN]
HEEEEEEEEEEEEEEEEE
nEEEEEEEEEREEE NS
HEEEEEEEEEEEEEEEEE N
aeaaaaaaaaaaaaaai
HEEEEEEEEEEEE
o E m m N m mmE g
HEEEEEEEE N -
T

EEEEE

Co W
mEEEE s

R, XPIKBHLEA R AR 248 (United States
TEA] ORI S SR BRI AR — B R R MR S B E R .

: Lambert Conformal Conic, meter) NIF#HEBMHFRIE R KD .

2.2 BRSANYIE

FZE AN (Advanced Tmport) DNREFTARAZAEAR, I HIRM T A HKBE T USRS E M. BIs RS, RHRiEiE
B DEM 775, BRSO NIV A A R . T A s St BV R DR DR BB AR Y, RO R T g



i EARAH B 6] AR H, ERHIAARFERKRK AR AR RGP, RER TRk E—
o

1. E Geographic Imager MR H, siili Advanced Import $%4H.
2. 7f Advanced Tmport XFiEHER, MAE T 2513 B i%$ GeoTIFF/BigTIFF/TIFF Jf 55 5 Browse.

3. Si4k #| Tutorial Data 3%, i%$¢ boston—east. tif, JfH S Openo WIRMEEUE, s OK 5 I~ W B % I E A K
ERRIE BAE.

Format: | <Auto detect format> v|[ Browse... || Remove || selectal || ok |

boston-east.tif Massachusetts Mainlan... | N/, 800 x 800

File Name ‘ Coordinate System 1 DEM Schema \ Dimensions ‘ Cancel

Reference File

ma—
Source Coordinate System

Massachusetts Mainland Zone
[] same as: v

XA, ESANNHFRERERHT boston—east. tif MEE, FHHERE T EMMLFRRS —Massachusetts Mainland Zone
LK% K/ 800 x 800 {43k

4. P& R AR Bk £ BCW I H A5 5 Browse.
5. S fi#k# tutorial data fF#, #%Ff boston—west. ecw, JfH 57 Opens

©



Advanced Import
Format: ECW | I Browse... | | Remove | | Selectal | | OK |
File Name Coordinate System DEM Schema Dimensions L Cancel |

boston-east.tif Massachusetts Mainlan... N/A 800 x 800

Reference File

boston-west.ecw ‘ Specify... {

Source Coordinate System

[No Coordinate System Specified] @ e B

[[] same as: boston-east. tif (Massachusetts Mainland Zone ) v

AEAEFIZR LGN T KT boston-west. ecw KIfEE, I HR /R HIZEBREA LIRS, ERFE RN 650 x 650 B
T8 ZAE M Advanced Tmport WIUHFIXLERAGA, XFEA BEFIHEIR -

6. TEXFIRE, 1EF boston-west. ecw I'E R ER. B FK, 7E Source Coordinate System #EH, fith Same As Hik

HE.
Format: |[ECW v | | Browse... ] ‘ Remove H Select Al ‘ l OK |
File Name Coordinate System DEM Schema Dimensions i Cancel |
boston-east.tif Massachusetts Mainlan... N/A 800 x 800
boston-west.ecw Massachusetts Mainlan... N/A 650 x 650
Reference File
boston-west.ecw | Specify ‘

Source Coordin
Massachuse Zone i@} @ =

Same as: |boston-east.tif (Massachusetts Mainland Zone ) '

TEAAFR R T HFIRE, HEEEZ boston—east. tif, KIAXHFIFREER T boston-west. ecw RAE—A. XFE, fEXHFIE

H, boston—west. ecw F IR RGHLEH AL T Massachusetts Mainland Zone. ## N3, SS3EE % N T EAHAEN GeoTIFF 52
BRSHES—T. .

7. Sii boston—east. tif [FH E=ER. NI, 7F Image Extents HEH, /&7 Resample #%$HFT T Resample Image XFiEHE .

8. KT SN 650 153 IRIFK T LH] (Keep Aspect Ratio) i&Tim] LARF{R & & 42 650,



Original Size: 800 x 800 px (Raw Size: 1.83 MB)

Resampled Size: 650 x 650 px (66.02% Raw Size: 1.21 MB)
Result Size:

width: |50 | pixels 8125
Height: 650 | pixels  [81.25

[¥] Keep Aspect Ratio

9. i OK.

10. 3XFf, Dimensions F1AEE SEHT A T 48 WIS\ FR ZERAE R /DN

Format: |ECW v || Browse.. || Remove || selectal || ok |
File Name Coordinate System DEM Schema Dimensions Cancel

boston-east.tif Massachusetts Mainlan... N/A 650 650

boston-west.ecw Massachusetts Mainlan... N/A 650 650

Image Extents HEH BT AL T B REEE IR/

Image Extents

650 x 650 px (66.02% Raw Size: 1,21 MB) Crop... | |Resample... | | Clear..

e, WS ER B R T A IR LS B AE i

11. 7EXHEHER) R, 5t Mosaic all files to the destination document i%GHE.
Mosaic all ﬁfnation document: lbostm—east.ﬁf(Massad’usetls Mainland Zone ) v
Mosaic options

[] Maintain layers using blending mode:

Mosaic Alpha Channels [] crop to current canvas Mosaic layers above destination layer

boston—east. tif file W/RTE T FIFREM, TR AR B AR TR,

12. Ay OK 58 i Advanced Import 4b3,



- boston-east.tif @ 66% (boston-west.ecw, RGB/8) *
I

BEFEFAEBB =

Reference File: boston-sast.tif
Coord System: Massachusetts Mainland Zone

Image Mode: RGB Color | & Angle: 0°

Genersl  Corners  DEM  Survey  Ruler
Geodatic format: Decimal Degrees
Image Size: 1,300 x 650 px
Image Extents: 3,000.000 x 1,500,000 m
Geodetic Extents: 0.03651541 x 0.01364423 ©
2.308 % 2.308 m

| 65.96% |2 Doc: 2.42M/6.45M

BUE, XA FEEAS AnT DU IRAE A — RS R T X MRIER BN S RISE D AT AR, BB RS,
BEERRAN, FEA SRR I (0 AL BSR4 2 O 45 K2 — FEI
£ Layers MR, ZHEBREZPFHGRER T —NEZE. BREADMOEE, ZAE Advanced  Tmport X 1HHEH 2)i% Keep

source data on separate layers &,

2.3 BRSA DEM iz

EHF NIRRT LLS N DEM S/ HLXF DEM AR (schema) #HTHE . EIXNE R, EIEEHEE LAY DEM Zids gk 17#:
PIbEE . R8T R TR E 25 BiE S R BV AL .

1. 1E Geographic Imager MK H, it Advanced Import #%fT#l.

2. 7F Advanced Import XFiHAEE, MAE T %13 BLi%k$E USGS DEM 3 fidi Browse.

3. S FN\Tutorial Data\Mt Olympus 3D Landscape Data /444, %4 MtOlympus. dem, 3f 5515 Open.

©



Format: | <Auto detect format> '” Browse... H Remove || Select Al Il OK I

MtOlympus.dem NAD23 / UTM zone 10N | Yukon Water 1047 x 1468

File Name J Coordinate System 1 DEM Schema ‘ Dimensions ‘ Cancel

Reference File

MtOlympus.dem
Source Coordinate System

NADS3 /UTM zone 10N =)
["] same as: -

ERAHFRE LR H T Mount Olympus DEM ##E, I H /R HAFR 245N NADS3 / UTM zone 10N, DEM K/MNA 1047 x
1468 5 %K .

LEXZK NI DEM Schema fEH., BI/RHT schema (Yukon Water). WIEEi% DEM Schema ¥4 Hah$i i —Auto—stretched, b
i Specify &1 FFIEFE Auto—stretched Bz, XA AT LAiE DEM #7148 o, B E S+ 2 e 1E .

4. 7F Image Extents HEH, 55 Crop %

5. MEAIZEAY (Unit Type) FHiFIR Bk Geodetic, FEHMALFRIEI (Coordinate Format) TF47413R Hi%k+$E Decimal

degrees.
6. fE/L LA (Top-left Corner) HEHL, ZFEF: B AN-123.750, Z5EF2 BN 47. 790,

7. 764 T (Bottom—right Corner) HEH, ZRFF:HHIA-123. 715, ZEEFH: HiA 47, 765,

©



= & B = M

Dimensions: 0.035000 x 0.025000 deg { 519 x 560 px, Raw Size: 567.66 KB )

Unit Type: IGeodeﬁc

Coordinate Format: | Decimal degrees (D+[.d*])

Top-eft Corner Bottom-right Corner

Long: |-123.750 | deg long: |-123.715 | deg
[-123.75210618 -> -123.68131389] [-123.75210618 -> -123.68131389)]

Lat:  |47.790 | deg lat:  [47.765 | deg
[47.81582986 -> 47.74935248) [47.81582986 -> 47.74935248]

Options

Partial Pixels:  (® Round to Closest () AlwaysUse () Discard

8. kil OKe
[v] oEM
Crop autorstre
[] Combine DEM value range in new schema
Image Extents
519 x 560 px (18.91% Raw Size: 567,66 KEB) | crop... ||Resample... || Cear.. |

WRYE I TE & W ALARE DG, BLTEZ DEM I R/NA 519 x 560 152 (M 1047 x 1468 {3 2143 5) . DEM Schema tH4F1E T “Crop
auto—stretched”, UiBHIFA 2 DEM H A EEEFEEIXA schema B,

9. EEARLFIX A DEM Schema, ibEH —ANEEMLHK, ATLLERIEKTCEIE.

10. #E3%X > DEM Schema HEH., #i7 Specify #%4.



11. 7F Import DEM File Xfif#EH, MAi&ttal) Create New Schema %41

i\ Rocky Mountains Cropped {EN¥#iH] schema &%, SXJ5 Al 0K,

SchemaName:  |Rocky Mountains Cropped

Lowest Elevation: |801

Highest Elevation: | 1933
File DataRange: [801->1938] |

Vertical Unit: Meter

IX AN 5 K0 DEM 3088 i m AR TR 2 801 2k (KD —1938 2k (Rm) .« fERVIZ AT, WL TafE 2 496 K —2429 K. #%
VIR b T — e i AR ARV Bl 1 e AR A

Open as elevation data
Select Schema: |Rocky Mountains Cropped: 801 -> 19381 + | Type  <Auto detect (DEM)>
DEM unit: Meter _” Predsion: 0.03 m

Maps spedified range of elevations to Adobe Photoshop grayscale colorspace.
Using common data ranges allows for importing multiple files using equal schema
and therefore compatible and mosaickable. Note that elevation values outside of
the specified data range will be mapped to the min / max color values.

12. gk OK SCPZST TR HE -
TE N I 304451 3% BLAN DE ema HEE, AJLLEF)IX DEM Schema MM EH T -
17 L R ¥ el AT @ﬁﬁo DEM fJ R/MBAE Image Extents MEELHUBTE R T .

13. 557 0K 5\ DEM,



@A Mtolympus.dem @ 100% (Layer 0, Gray/16)

RELAEEB =

MtOlympus.dem

NADS3 / UTM zone 10N

Standard

Gray Scale | 16 Angle: 0°

Corners DEM Survay Ruler
Decimal Degraes
519 x 560 px
2,595,170 x 2,800.184 m
0.03455224 x 0.02541376 ©
5.000 x 5.000 m

T




3RBHSE

3.1 HGHESE =

XA S Ad G IE ST 215 2 L BN 56 2 g M ) Lafayette WX . Z B A S EEE. HENTHIFE, B©F 6 1%
BRIk, PR T EBONZREIR S E RN s s S A &

1. #£ Adobe Photoshop B, M Tutorial Data X f4}3¢ F#TJF Lafayette. jpgo

f£ Geographic Tmager Mi# H, Reference file FHLEATHRE M, PINEREIC R BBAMMKSH L . FME, L
PRAGAE A B T E AR R GG B

2. ¥F Geographic Imager MM F, il Georeference 1%

SRR ASSZ NADB3/UTM Zone 16N #2AMR R 50, f&mT LU A AR ARG JLAR 9 B0 A8, (ER 0 T RSt 4m] USIN WGS
84 LB R AR DR RGEAE Iyttt S AR .

3. PERCAR TN P 1 23, Ao P LA i HEAT P R 4 O L B /e M et Sk 1 IOBE B

4. piidi Add Point $4H LTI I bR sl ah R (R S oA (A R AL LT, K T B R OR 2D

y A oK
| concd |
E ‘ Unreference
3
f
=~
(=]
v E o
- ; 4
< E — >
Image: (806, 35{‘ ’} Image Size: 2,508 x 2,508 px | Zoom:
(%] [ Rectify using:  Affine (min 3 points) -
Use Name PX PY Coordinate System WX wy PXY Error

IXKE, BRIE 352, 489 MR E AL B AN T — N EHI A Point 1. 4 S R EMEZ T —41T. BEN Point 1 IIn—AMH FAkFR
PABIEE — A a5 1 ) 5 (0 B S B L% AR VE M T R (3 7, QB A XM A A s E T AU A .

5. fEFEH A FIFR R, Wi Coordinate System, WX, B WY BT,
6. VEFEWGS 84 AbRARGL, RJEHIN:
® Lat:40.417492

® Long:-86.860779



Coordinate System: () None
(®) WGS 84
Input format: Decimal degrees (D+[.d*])

o lat: | 40.417492

« Long: |-86.860779

7. 355 OK.

ZRE, RIEEPA T Z TR

@ = [[] Rectify using:  Affine (min 3 points) v
Use Name PX PY Coordinate System WX wy PXY Error

‘ Point 1 35 89 ; WGS &4 |-86.860779 40.417492

>
8. i FH bR PR BIRAR AT LAY 2 B4 sy Sk dm il .
9. A7 Add Point $4HLIF HLlEff sieh 58 — AN EIET AR .
10. fEFHIE £, A Point 2 FNUF HUFEAL R :
®  Lat:40.420841
®  Long:-86. 839035
@ E ﬁ [J Rectify using:  Affine (min 3 points) v
Use V ame PX PY Coordinate System WX wy PXY Error
1 Point 1 352 489 WGS 84 -86.860779 40.417492

} Point 2 2,196 - 40.420841

FEAINEE =AMV L, EFHERA—A CSV Xt

11. /i Import Additional Control Points f%#H. %% Tutorial Data (3, #£#% Lafayette point3and4. csv, i
Open.



@ v 1 | « UserGuide, Tutorial & Data » Tutorial Data v o Search Tutorial Data

Organize v New folder = -

| b ¢ Favorites I )
4 & OneDrive '
| Documents A ¥

) Americas Landsat 7 Mt Olympus 3D Rocky Mountain
> {8 This PC Multispectral Landscape Data 3D Landscape
Data

» € Network B - s
s,
- |
Sample Scripts dakotas_gcp.csv Lafayette_point3a
ndd.csv

File name: | Lafayette_point3andd.csv v [ lAlI supported formats (*.rsf *ta v |

[ Open I | Cancel |

Kcht, BHE Point 30 Point 4 HEMIEIFIAAIBIGHIE R T % CSV SR @IR T QBAHRRIERAHR. 7T LB 7 3)
WAL B 5 =R D) AR k. TR AN 36 A RS

Unreference

] 2] [#] [©] = @] [®E]

Image: (2,198, 2,164) Image Size: 2,508 x 2,508 px | Zoom: |214% |
Izl = @ [E] @ [[] Rectify using:  Affine (min 3 points) v
Use Name PX PY Coordinate System WX wy PXY Error
1 Point 1 352 489 WGS 84 -86.860779 40.417492
2 Point 2 2,196 114 WGS 84 -86.839035 40420841
3 Point 3 2,004 2,098 WGS 84 -86.841339 40.402973

</

‘ Point 4 649 ,380 WGS 84 - 315 40.400444

12. 45 5 SE LA N — M2 H .

13. A EL st Sk bR (Assign World Coordinates Online) %4H.



Assign World Coordinates Online SFiHAERLFTH T — NI IXASThRE LT /X 25 b 18 R 238 FAN 1 Aok 3] 5 2 AL
R A=RELY 7

14. BRI MILE S 47 B (Matching Point Location) THi#|FEHEi%E#E T Point 5 (R$EE —UNASSIGNED) .
15. i SATELLITE #ZH11)3e 3] TUE M2 th KA T .

16. fFFH H e SAE RIS H R B 5 NMEH AN E . (EfF Sagamore Pkwy A1 Kossuth St BFIIAZ X M) . HiEFLBIXA
W5 OB, HERf S IX M B AR R AR XX E L) o sl Yes 45 Point 5 43fic— AN A AL AR

Assign World Coordinates Online

Matching Point Location: | Point 5 (UNASSIGNED)

i

Click map to assign world coordinates to Control Point 'Point 5'

[Enter location | | Search

Search is only performed within the displayed map extents
Nominatim search courtesy of MapQuest

s
-

&) LRI 4E Georeference $FiEHEAT Assign World Coordinates Online Xfif#E.



Assign World Coordinates Online

——— | Cx]
Click and drag pin to change its world coordinstes. Carcel |

H

Nomnaem seaccn ourasy of aoues £

A

@ BPFEGFE &

4/5 points in use | Georeference is rvald ‘

Image coordinate system must be spacied to reference.

17 XA R (RJa—A) HE Lm#eE.

Georeference

Matching Pont Location: |Ponts
Clck and drag pin to change its world coordinates. | Comcel |

Image: (1,934, 1,%3) Image Size: 2,508 x 2,503 px |

8a @@ 3 O [ Recefy using:  Afie (me

Use Nome. o Py Coordinate System wx wy

£l Point 2 219 m WGS 84 -86.839035 40420841
£4 Point 3 2004 2008 WGs 84 86841339 40402973
¥ Pointd 549 2380 WGS 84 -86.857315 40400444
“ Point 5 600 1301 wes 84 -86.857861 40410208

56 ponts i use | Georeference is nvsid
Image coordinate system must be :

AR ST (Method) BRINEE AT (Affine) , XFEER/DFE 3 AN H. R ZHRHATARG RS, —
M R ER R ORI A T IE . B WU R AT B 2 3 dl R T AR B R ST ONAS S T 2 35 0 2 by
B o

18. Al Solve ¥4

XA Solve W& FE T 138  MEH] st H AR BB AR AL bR R R (X HUE N A T 6 NMElilR) » XA REWBLIMLES
RZEEML. AEEH O TR, MR R, Sr 2 R AHUCE AP R . AERXFENL T, BRI
HALFR 2G5 2 NADS3 / UTM Zone 16N #ALbR A%

19. 7EARFR R G551 22 B, 1%69% NAD83 / UTM zone 16N I 55 OK.



Name Rank  CombinedError  Rotation  Shearing
WGS 72BE / UTM zone 16N 100 0000012732989 deg 0.025deg  0.046 deg

WGS 72 / UTM zone 16N 1.00 0.000012732989 deg  0.025 deg 0.046 deg

UTM Zone 16N (90 W to 84 W) 1.00 0.000012732989 deg  0.025 deg 0.046 deg

WGS84 UTM, Zone 16 North, US Survey Foot 1.00 0.000012732989 deg  0.025 deg 0.046 deg
NADS3 / UTM zone 16N 0.000012732989 deg | 0.025 deg

NAD83 / BLM 16N (ftUS) 3 0.000012732989 deg  0.025 deg

Indiana Western Zone : 0.000012733021 deg  -0.029 deg
NAD83(HARN) / Indiana West 2 0.000012733021 deg  -0.029 deg

NADB3(NSRS2007) / Indiana West (ftUS) A 0.000012733021 deg  -0.029 deg

|Error Details.. | |Coordinate System Detaiks... | |Show More Resuts|

AR R AR M R A B IR CR ARG R EGE FRAD .

(%] =} EH ] Rectify using:  Affine (min 3 points) S5
WX wy PXY Error PX Error PY Error WXY Error WX Error WYEror A

2 -86.839035 40420841

3 -86.841339 40402073

4 -86.857315 40400444

5 -26.857861 40410208

6 40410433 1.544398 px 0.960864

<

Image Coordinate System: NADS3 / UTM zone 16N 5 Solve...
6/6 points in use | Georeference is valid
["] Enable Advanced Options
Forward Residual: 1.650323 (X: 0.543740, Y: 1.558176) |_| Remove Shearing Difference in rotation 0.048 deg
Inverse Residual: 1.650263 (X: 0.543619, Y: 1.558155) ["] Square Pixels x pixel size: 1.000, y pixel size: 1.000

AT WNRZE, AU S A BT R, B AR ]S RS AR SR A G S R R A . B,
i Validate T. AN View Image Extents Online AN\ I1Z2% kS = anf] .

20. {fi[H] Validate T.H NS EBAESE

Mg Validate T HE 1 $ 36 7] PRI #R1E Georeference FHHAE,

21. piih Reference R5EHUGLAZ R S B HAE . R H I BAENIE, S EEMS# (Continue to reference the

image) .

L, BB OERESHE T . Geographic Imager MR EEHIL T — AN %FA Lafayette. tfw IS0, HHAR RS
N NAD83 / UTM zone 16N. BRIAZSZ CAFHEAA World (tfw) o IXFHGCnT LEE .



e
Y@ EBRFEFAERRRB =

Reference File: Lafayette.tfo

Coord System: NADE3 / UTM zone 18N

Mode: Standard

Image Mods: RGB Color | 8 Angle: 0°

Genaral Corners DEM Survey Ruler

Geodetic format: Decimal Degrees

Image Size: 2,508 x 2,508 px

Image Extents: 2,507,347 x 2,510.645 m
Geodetic Extents: 0.02360172 x 0.02265706 °©
Pixel Size: 1.000 x 1,000 m

22. BURAES ARG S 11E (BARE H SR A 1E80) , W LALE Adobe Photoshop 32 HL fihi File > Save. &%
A Lafayette. tfw AR AR I B SCHRAEER — 842 F . sk, EaLMEFABEN (Save As) BHAERSA —Fig, &
¥ TIFF (RERs 2B ARAFN GeoTIFF) .

3.2 RENIFKZS3E ( Quick Georeference ) S

Quick Georeference X AGPIH FIHH TS 71k (EHZ 7B A %M
o  UREA AR G BIREIL T A5 o

o HTRENIMRRALBERSH . B, REg—EMNEAMRR X/Y GRS BbR. (BN, £ R AR
AT AR & L, XA KASREAEAH R X/Y il EXS55) .

FEIXANR B, DK — S R E) W6S84 ALFR RESE T .

1. 7E Adobe Photoshop | Tutorial Data CfF¥4TTF Americas_4. tif.

KRB REARESHEN . BHWAFE UL R —BA e R ER B A7 X 55

2. {E Geographic Imager [HI#i H. 517 Georeference #%4H.

3. ff Georeferencing XMiFHER, MR G IAM) Add Control Point 3%#H. s o fAAG A B L AT &AL BRI IN— 5.
XFE, EPEH] R BRI T Point 1. SEEER R — MR AR (PX AN PY) I HLE IRt S A8 85 (WX A1 WY)

4. % PX BT, N 599. Wi PY HLUG, #i 0.



Point 1

] (2] [#] (€] Ir] @] [E]

@ -

Image Size: 600 x 457 px | Zoom:
= & BH Method: | Affine (3 pts) -]

Name PX Coordinate System WX

< I ——

Image Coordinate System: Specify...
0/1 points in use | Georeference is invalid

[] Enable Advanced Options
[ Remove Shearing

The coordinates of Paint 1 are not valid. _
["] Square Pixels

5. X it Coordinate System, WX B{ WY BT,

6. 1% WGS 84 AHr R %, 7E Lat R2H M 35.917, 7E Long A~ B4 A\-50. 064, #RJ5 7 OK.

Coordinate System: () None
®) WGs 34

Input forma Decimal degrees (D+[.d*])

 lat: |35.917
« Long: |-50.064

FEFE ] R B3 BUst o T ST S ) AR R B



@@ 3 B@ @@ Method: | Affine (3 pts) =

Use Name PX PY Coordinate System WX wy

-50.064000 35.917000

TAER B BRI AR H A XK, AR AR PX = 0, PY = 456; JFHLAEAIH 4R Lat = 6.731, Long = -
88.417.

B x B E# = EE Method: | Affine (3 pts) =
Use Name PX PY Coordinate System WX wy
Point 1 WGS 84 -50.064000 35.917000

PUAE, WIS B &0 7. FIEEEAT UEH Quick Georeference Thfg.
8. At Quick Georeference 1%Hl 71 Hi%#% By Two Reference Points (North/South aligned) i%Ti.

XKE, EPEH] ARG B AN 7 53— MR e RS AR R T A X PN RO T A R . BRUOAXTRE
BIKSH 2 DTHE 3 MM AL TR, TR E RIS R 5t

Ex BE BE B Method: [afne 355) :
Use Name PX PY Coordinate System WX WY
1 Point 2 0 456 WGS 84 -88.417000 6.731000
2 ﬂ t 1 599 0 WGS 84 -50.064000 35.917000
< >
Image Coordinate System: Specify... 55 Solve...

3/3 points in use | Georeference is invalid
["] Enable Advanced Options

[] Remove Shearing
Image coordinate system must be specified to reference. _
_ | Square Pixels

9. S i Image Coordinate System HEFLHJ Specify 4%4%.

10. 7£ Choose Coordinate System Xi&HHEH., piidi[No Coordinate System Specified]#f#%.



11. 7E Specify Source Coordinate System XJiFHEHL, fEH CoordinateSystems > Geodetic > World H3, #E#E WGS 84 4%
ARG, M OKo

Datasource:  C:\Program Files\Avenza\Geographic Imager\Data Source Files\geodata.xml
Custom Data:  C:\ProgramData\Avenza\Geographic Imager\customsystems. xml

Folder ~|©@ £ Display Name  Name Horizontal Datur Point St A
Asia PZ-90 PZ-90 Parametrop Ze... Degree
Europe Unknown datu... Unknown datu... GRS 80 Degree
Misc EPSG Unknown datu... Unknown datu... Naval Weapons... Degree
North America Unspecified dat... Unspecified dat... Not specified (b... Degree
Oceania WGS 66 WGS 66 WGS 1966 Degree
Other WGS 66 WGS 66 WGS 1966 Degree
Outdated (Deprecated) WGS 72 WGS 72 WGS 1972 Degree

> South America WGS 72 WGS 72 WGS 1972 Degree
World WGS 84 WGS 84 WGS 1984 Degree ,
> Projected >

[+] = [+] & 7 @] 3]

DQDDDDDDD

~
N

10. A5 OK 2% Choose Coordinate System $fiffE.

Coordinate System:

ot

[] Same as: Dakotas.jpg (NAD83 / Conus Albers) =

ZHE, B R G o BUEMCEMERLT 1, WL RAA e IR S5 e ff

Image Coordinate System: WGS 84 Solve...

3/3 points in use | Georeference is valid
[] Enable Advanced Options

dResidua: 0, x:0. . ¥: 0.000000) [ "] Remove Shearing Difference in rotation 0.000 deg
Inverse Residual: 0.000000 (X: 0.000000, Y: 0.000000) ["] square Pixels x pixel size: 0,064, y pixel size:0.064

11. i Reference Bi5ER T 13RS il .



e
W @ENNELERHB =

Reference File: Americas_4.tif

Coord System: WGS 84

Mode: Standard

Image Mods: RGB Color | 8 Angle: 0°

Genaral Corners DEM Survey Ruler

Geodetic format: Decimal Degrees

Image Size: 600 x 457 px

Image Extants: 38,41702838 x 25.2500043% ©
Geodetic Extents: 38.,41702838 x 29.25000433 ©
Pixel Size: 0.06402838 x 0.06400433 ©

Zitl, XA SCRELR IR LT PSS B
3.3 URLMIE ( Rectification ) 20F=

BT ZAEH] S K Rectification BLE "8 krhifif (rubber sheeting) 7 £iZE— ME AR B LTS5 . HRIFAFHIIL
A (22%5) Hik, IEMIAIEAIEEE R AR LU, XHBATET R B4, X6, ML R
T2 AL BR R HFAT T -

TEXANGT R, B — TR ARARBERS R A D7 S ML ], 3 AT IS A IE B WeS84 AR RA T . i H A4 MAZ XK,
N FE ) A A B LT . R B e B LA A R AR AR . A IEREAE H Ik 2 WA R (Quadratic
transformation) 772,

1. £ Adobe Photoshop B, #k#| Tutorials Data 3 f4:3&, #JJT Dakotas. jpg.

EE, ﬁﬁ%ﬁ%%?ﬁﬁ\%o B, BESIANCAMES S, BeiPr— SR 2 uEmmiii g, SR S
SEMMR S A

2. 1F Geographic Imager H, i Georeference %4



] [#] [#] (€] ] (@] [E]

@ »

Image Size: 3,297 x 4,256 px | Zoom:

Bx EE

[] Rectify using:  Affine (min 3 points)

v

Use Name

PX

Coordinate System

]

WX

wy

PXY|

0/0 points in use | Georeference is invalid

At least 3 points are required to reference or rectify.

PR, BN — B

3. 557 Import Additional Control Points #%#Hl, % dakotas gep. csv, ZRJ5 s Open 4 BT A35 i S H#R R N 3

Georeference FHifHE HL .

& x

Image Coordinate System: Specify...

["] Enable Advanced Options
[ Remove Shearing
[ Square Pixels

[] Rectify using:

Affine (min 3 points)

Use
1
2 Point 2
3 . Point 3
4 ‘ Point 4
5 ‘ Point 5
6 Point 6
<1

Name PX

342
2,619
392
2,773

1,516

PY

Coordinate System
WGS 84

WGS 84
WGS 84
WGS 84
WGS 84

WGS 84

WX
-104.049000

-104.052000

-97.000000
-104.043000
-96.561000

-100.512000

43.000000

43.000000

49.000000

45.944000
45.936000

45,944000

RGBS H SR BRI T 6 MEwl A, AT HELY, HAi 4 Mk SE S 7T IEmPME R, Bk
T EH A S S (Point 1 A1 Point 3) BBIIEMAINME. EE, Point 1 F X&Y AR Z&-104. 049 F1 49. 000 J¥.

%

4 HGIE B, HCRE] Point 1 GBARE L) WIGLE . 157 Select Points %4, )5 il Point 1 KAHAEH] 49° L

FoANEAELLXLE LTFED .



)

49

— 49

-

|

PLLE Point 1 ®iAS3 T IEMIMIAIE, KZ1-104. 000 AT 49. 000 .

SRR, 1EE Point 3 KIHFALFRA-97. 000 AT 49. 000 /.

IR ER R LA E L.

5. ERARALE L, JORHRE] Point 3 GRARKIA LA o KRS 49° ZRER 97° L X .

Point 3 BUEME IEHIUALE BT, KZ-97.000 Fl 49. 000 fE. Tk, BEARMNF P NHIES] AL AREEPEEEMRIE

Jiike

6. siili Add Point 4%, BUFRIHb T R B AL E . Sl 101° 2R 49° ZAZ XAk, (Wi ZEME, M Select Points

THRA A SRR E . ) A H s b, X WX B WY foe.

7. 76 Edit Location xﬁ@mt FLEHN 49, Long REEHA-101, 4RJ5 fid OK.

EMBINA

= 5 :
Edit Location
Coordinate System: (@) WGS 84
N/A
Input format: 'Decimal degrees ©O+L.d*) Cancel
« Lat: 49 | deg
« Long: |-101 o

Point 7 A T E M T AR




@ ‘g = \;j_\ E P {fﬂ [ Rectify using:  Affine (min 3 points)
Use Name PX PY Coordinate System WX WY
2 Point 2 342 3,387 WGS 84 -104.052000 43.000000
3 Point 3 2,576 633 WGS 84 -97.000000 49.000000
4 Point 4 392 2,036 WGS 84 -104.045000 45.944000
5 Point 5 2,773 2,015 WGS 84 -96.561000 45.936000
6 Point & 1,516 WGS 84 -100.512000 45.944000
I N N [N BTN -

8. 7f Add Point #ZHHIRBELEIELL T, WS 21 K AR WAL, sy 101° 26N 43° 2R XAk, fE Point 8 HAT XU

WX BE WY BEG. Lat B2Hi At A ALK 43 , Long B2 At AR ALKR-101. i OK.

@ @ @ @ E @ L:: [[J Rectify using:  Affine (min 3 points)
Use Name PX PY Coordinate System WX wy
3 Point 3 2,576 633 WGS 84 -97.000000 49.000000
B Point 4 392 2,036 WGS 84 -104.045000 45.944000
5 Point 5 2,773 2,015 WGS 84 -96.561000 45.936000
6 Point 6 1,516 2,054 WGS 84 -100.512000 45.944000
7 Point 7 1,375 WGS 84 -101.000000 49.000000
Point 9 1,367 3,401 WGS 84 %
>
A TIX 8 A sk, T LU R R A IR T

O ity R R ] OE SRR BP0 TE 4R, R — A LeBe & B 2] TE 745
SRR KSR e Al RERF Bl A AR .

BTk, TREARE WS 84 fEARMGINALFR RS, RJFIEFE—Fh 2 IE 7ok 5E A IE .
9. &y Image Coordinate System HEHL[{] Specify 454
10. 7£ Choose Coordinate System ¥fif#E, siidi[No Coordinate System Specified]###%.

11. 7E Specify Source Coordinate System XHiEHE, JEJF CoordinateSystems > Geodetic > World H%, iEFEWGS 84 Aikx
RE, s 0K,



Datasource:  C:\Program Files\Avenza\Geographic Imager\Data Source Files\geodata.xml
Custom Data: C:\ProgramData\Avenza\Geographic Imager\customsystems. xml

Folder ~|©@ £ Display Name  Name Horizontal Daturr Point St
Asia PZ-90 PZ-90 Parametrop Ze... Degree
Europe Unknown datu... Unknown datu... GRS 80 Degree
Misc EPSG Unknown datu... Unknown datu... Naval Weapons... Degree
North America Unspecified dat... Unspecified dat... Not specified (b... Degree
Oceania WGS 66 WGS 66 WGS 1966 Degree
Other WGS 66 WGS 66 WGS 1966 Degree
Outdated (Deprecated) WGS 72 WGS 72 WGS 1972 Degree

1> South America WGS 72 WGS 72 WGS 1972 Degree
World WGS 84 WGS 84 WGS 1984 Degree 'f
I Projected >

[+] = [+] & 7 @] [3]

DDB’DDDDDD

~

12. fiis OK 95 Choose Coordinate System XiHAHE.

Coordinate System:

ai

[[] sameas: Dakotas.jpg (NADS3 / Conus Albers)

13. 55 Rectify using Hi%#E, 1%£F% Quadratic Polynomial (min 6 points).

Quadratic Polynomial Jyigefii FH 2570 6 AN 5] SR T EA B LU IS H T . G RA FABPRR ZESTERR/ADN OKTHE
HSHHRA LG FNRZE {EF WGS 84 1ENFAGALAR R G R INE G L E NS R A S IR K Ik Z Y 1E
VRN WGS84 AR R4 % UL P2 TF Al — NS FH s A b RS 25 (1 b I

14. /iy OKo 3 a2 % I & i Proceed to rectify the image.



You have chosen to rectify the image.

The selected control points, method, and image coordinate system will be used to rectify the image.To
complete image rectification, Geographic Imager uses the Transform feature which also allows for
adjustments to pixel and advanced options.

< Proceed to rectify the image.

This will open the Transform dialog box where you can complete the image
rectification.

Anors o -

15. Sl Transform 5S¢SR A IE .

Destination Coordinate System
Destination: WGS 84
[ ] same as:  Select Document

Datum shift: [No Datum Shift Required]

pixel Options

Pixel Size: 0.00217265

Pixel Dimensions: Preserve existing

Advanced options

Layers: Leave intact v [#] Trim transparent edges
Resampling: INearestNeiy'bor(pr&servehadedga) VI
Precision: | jormal v | Stipwidth: 50 > pixels

XFE, HUfEF Transform T HSER T WG R IE . Hila, AR IER] T WS 84 AR AR T, W&, WER WA E
R EN . HIER A IERSEE, 7 LMEH Georeference FHEHERA Validate T H.
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4. BHREERR

BRI L ABUR LA — B R AUR 2 2R S SiE , 46 IE ST 5245001 DEM SO, XS IR 2 # 2 e 9e ). 8H, 1X
S A A T A 20 L M, AR 22 B T BN X e B R S IR AR B — A B ) TE 4 T R I A X S R Bl SR
Geographic Imager it n] A IX S AR 4 IR AR i — A B I & 5 I 2 5215 .

Mosaic ZHE ] LUK 2 Nl A7 M B 225 ISE AR 5 R AR G — AN SRR AT B S B 10 5 AR, 4% DEM SCPF . Bk b
P BRI ST AR AN AR PR R GE . ANFMRER KN AR A LR o IS SCAF R e SN e 4 B LR BB ST A 10 s 12k
B HHEATHRRIN 3BT DU R R R TR SR B ARAR R G FURFHR R R/ e e A

4 TSGR A, H I PR FE AR R G R 2 RALAER F B XN —FEHI B AL br 7 2o

O o5 RSP ekt B, R SRR T R TP T e . BEAR A HE ) AR S
PRELE, AR S L AR B AR SCIA AR R BO AR R G R K DAIIERE L

a1 EEERENTE @

FEIXANGR B, SR B A AN R A4S R LK LA S AR IR AE — A N B AR R AR

1. 7£ Adobe Photoshop ¥, ##|\Tutorial Data\Americas X432, fTJF Americas_l.tif, Americas_2.tif,
Americas 3. tif fl Americas_4.tif {4

2. 1F Americas 4. tif XfFH, 7F Geographic Imager Mtk H &t Reference file HEF] Specify BE#E. iE#F

Americas_4 reference. tfw, il Opens



@ ESEFAMEER =

Reference File:  Americas_4_referenca.tfur
Cnord ; sml* Mn‘l
Image Mode: RGE Color | & Angle: 0°

Pixel Sze: 0,054 x 0,064
m "."I

XEERLINE T S, {BSE Americas 4 IR R FEMBIFRGER .
3. & Geographic Imager K Coordinate System HEf] Specify #E#:, s Same As EikAE, M FHid) R Eik$F

Americas_1.tif (WGS 84).

Coordinate System:

WGS 84

Same as: | Americas_1.tif (WGS 84)

4. pihi OKo
5. Wi\ Americas 2. tif @Iﬁi, {E Geographic Imager Mt I it Mosaic % 4H.



Mosaic

Destination Document: Americas_2.tif [United States: Lambert Conformal Conic, meter]

OK
Available Documents: Total: 3, Selected: 1 Mosaic Documents: Total: 0, Selected: 0 )

x — Cancel
Document Incompatibility

Americas_1.tif
Americas_3.tif

Americas_4.tif

Document

+ [ [

= € = =

Mosaic options

Maintain layers using blending mode: | Normal v | Place mosaic layers above destination layer
Mosaic Alpha Channels [] crop to destination extents
Advanced transformation options

Layers: Leave intact v

Resampling: Nearest Neighbor (preserve hard edges) v

Precision: Normal v | Strip width: 50 +  pixels

o

VER, Americas 2. tif j& Lambert Conformal Conic fEEZARFR RS, ‘© & HAMERCH, MR RE TG ags iy
ZAHE I AL bR R G ARG AT — . TR OIS T LR AR R ALRR R GE . ANFEPUE R KD E ess M, #nL
TO ¥ B AT R R . IR SR FAZOK DL B AR SO AR AR RGRUE KN briE

O RS PEA e A BE s RS ST R TP AT R . BEAR R A e 0 AL
PRELEIE, AR A SCIF L IR H AR SR AR R B AR R G BB K/ DA 1

FERRADO T HE L 2 S R R RSO o B2TOR, i s LR 0 5L f

5. miift Transfer ALL #%4H, 4 RrE RSO RS SIREIR SR 2L .

©



EE I

505 1 = B R K 1

Mosaic Documents: Total: 3, Selected: 3

Document

ATERFE, BEEA KN IF HARE

it

[V] Mosaic Alpha Channels
[] Crop to Destination Extents
v | stripwidth: 50

v

i
i
W
5
1

Available Documents: Total: 0, Selected: 0

o

pay

Incompatibility

|Leave intact

Resampling: [NeaatNaybor (preserve hard edges)

R

]

Document
f

N

Place Mosaic Layers Above Destination Layer

Advanced transformation options

Mosaic options
Maintain Layers
Layers:

Destination Document: Americas_2.tif

1,

A LLf#E FH Advanced Transformation Options 3RX} A4
N

TR
6. miily OK JFoR et AL BE .

R
N



XFE, BLLE Americas 2. tif CAFHLSERL TAEMR, HALFR RSN Lambert Conformal Conice

o
(Pxnd @ © T HOA& Y
[Normal 3]0931-'-!1:
B8 o]

® VES Americas_i
a8

Background

vES Americas_3

E Background

YES Americas 4

B

£

Layer 0

@ X, @ © O ]

¥ 7 Adobe Photoshop Layers HitR. VEE, H'EXHAERSE TR T Americas 2. tif B, FrAMEEECITFLHMEHE T T

Sk, BB T Keep source data on separate layers &M, BrlLLETRBEREZS A WEE B EES E. XFEA]
DME G iR B E SR s . AEPFE AR 01, 1%+ Layer > Flatten Image.

©



5. &R DR

G (Tile) ZHREAR RAMIBYI D M AN AR XEEAT IR A PR 2 BRSO BiE . iR FE5
RAMBSHER], BAnEERZEREMASE N (B EEE SN SHE B, W GeoTIFF, BigTIFF Bl
TIFF) o 2y e (1 i T LA i 44, ] BA%AT 515 B f AR bR A 44

— R B 9 T AT

5.1 DIREEE

TEIXANGR S B, BN — S G e N E IR
1. £ Adobe Photoshop B, #£#F|\Tutorial Data\Americas 343, FTIF Americas mosaic. tif.
2. 7F Geographic Imager , M Tile #&41.

3.7E Tile AIEHERE, #%£4% By Number of Tiles i&If, fF Horizontal fll Vertical SCAHE BEHIAN 3.



Tiling Schema
(® By Number of Tles () By Size of Tiles

Horizontal: (3 | Horizontal: 445 Units:  Pixels
Verial: (3 | Verticalk 34

Qverlap

Horizontal: |0 | Vertical: |0

[] Keep images open

Naming: Sequential Numbering
Reference File Format: [GeoTlFFlBlglFFITIH:

1f Destination #EH, it H3hEREMELECHN 9.
4. 7F Overlap HEH, 7F Horizontal Fll Vertical SCAHE A HIN 5. FEMHLRLE Units N8 Hik$E Pixels,
Overlap

oz [5 | e e —

KR, HUIEIERI A 5 MERIES.

5. M\ Naming F$i%13 B %% Separate Row/Column Numbers.

BEA TETIR (19 42 Pk BLRE (L0 IR A2 R I 4 PR+ E B IAT 140 5

6. M\ Format T +i%13% Hi%#¢ GeoTIFF/BigTIFF/TIFF.

Destination

Total Files: 9 [ Keep images open

Naming: |Separabe Row/Column Numbers vJ Precision: 5 =
Reference File Format: :GeoTIFF/BigTIFF/TIFF v:

7. w5 0K



8. NIXULH FIE I E — MRERE . EXFEN T, 4RI (Americas_mosaic 1 1.tif), fiii Save.

€ 2 1 j <« User Guide, Tutorial & Data » Tutorial Data » Americas » Tile v ¢ Search Tile

Organize v New folder

I 4 ﬁ Favorites | No items match your search.

|> #@ OneDrive
> {8 This PC

b ﬁ Network

File name: | Americas_mosaic_1_1.tif

Save as type: | TIFF (*TIF:*TIFF)

Save Options Save: [] As a Copy Color: [ ] Use Proof Setup:
[7] Notes Working CMYK

[]ICC Profile: sRGB
[ Alpha Channels ECH1966-2.1
[] Spot Colors
Layers

Other: [¥] Thumbnail

(4 Hide Folders

9. I TIFF Options XHiHHERS, 7 OK #:ZBRINEE .

~ Image Compression — Pixel Order
(e) Interleaved (RGBRGB)
() Per Channel (RRGGBB)

~ Byte Order
(s) IBM PC
() Macintosh

-~ Layer Compression

(®) RLE (faster saves, bigger files)
() ZIP (slower saves, smaller files)
[ ] save Transparency () Discard Layers and Save a Copy

TR 2 N BB Ja A R T BRSO GRAIEOLARE 9 AN EIIED o SR ARG 2O X LE IR AT AL BUR 4 AL BE AR 15, 7T BL
FRAGE R E .

10. SEMIPIRACE G, $RE) H AR L A XL IR



< 5
Americas_mosaic Americas_mosaic Americas_mosaic
_11f 124 1.3

Americas_mosaic Americas_mosaic Americas_mosaic
_2_1.4if 2 2tif _2_3.tif

Americas_mosaic Americas_mosaic Americas_mosaic
314f _3_2tif _3_3.tf

Z AT ERATA S A S 2] T X e A . NS America mosaic 1 1. tif B THE—ATH—51;
America mosaic 1 2.tif /&% —4T% —%l; America mosaic 1 3.tif RFEE—ATEHE =4, WA,

©



6.5 F A

#HY) (GeoCrop) THREARXNH A LS AR IE TG E AT v DUl LR U7 2R g #bIve -
e  FrhllE

e TR

o BT IR AU AR

o ETUfANfM

® LT R bR RS 2

o R TARITRE R

o ETMREEHEIF

HIRERII S L%, GeoCrop X1 HE HL AR Tl b P 2> S BT o B UIVE R . V)R i 2 [ R R IR E S E
KEFAZME

NS

S Advanced Tmport ZHEER] M H] GeoCrop DhfEF A AT WERIRAG GBI ORI S IR R

HHIEZEE /A alpha JHiE .

N LR
7 )

Crpﬁéalie :

GeoCrop ZYGEF] LAFE T 1R FALFREG I/ FEGAL T KA 1T 86 VAL P o



6.1 GeoCrop £iE

GeoCrop DfiE R % T 5E W EVIE X 76 228 IR Rk AT 8 V)

1. £ Adobe Photoshop B, #ZF|\Tutorial Data\Americas Xff¥&, #TJF Americas_l. tif.

2. ¥F Geographic Imager B, #iili GeoCrop #%+H.

3. M Unit TFHid 3 HikEE Geodetic, FFHM Coordinate Format FHislFe Hi%k+% Decimal degrees.
4. 7F Top—left Corner HEH, Long £ B #iAN-122.50, Lat £~ HE#iA 62.50.

5. £ Bottom-right Corner #:H., Long =B A\-91.50, Lat £ E#i A 39.50.

= & = ool ] (]

Dimensions: 31.000000 x 23.000000 deg ( 484 x 359 px, Raw Size: 509.05KB )

Unit Type:

Coordinate
Top-eft Corner Bottom-ight Corner
long: |-122.50 long: |-91.50
[-126.66666667 -> -88.25000000] [-126.66666667 -> -88.25000000]
lat:  |62.50 lat:  [39.50
[65.00000000 -> 35.75000000] [65.00000000 -> 35.75000000]
Options
Partial Pixels: (@) Round to Closest () AlwaysUse () Discard




Je EARUVA S A bR A R T DI DO, RN LR AE . 1% DAL T Adobe Photoshop ) Crop TR, NFEZAIMETE
RE I 1 £ 3t TR A b oAl S R DV

6. A TSGR VNG, v REAME A DY Ay 2 25 6 5 B T 33 38 UKD

XHE, DUAARAR A ZE T A o IR AR AOT SRPLHEH AR —Fh 7 i

Top-eft Corner Bottom-right Corner

long: |-122.50486111 | deg Long: |-97.14986111 | deg
[-126.66666667 -> -88.25000000] [-126.66666667 -> -88.25000000]

lat:  |62.50382932 | deg lat:  [44.39059081] | deg
[65.00000000 -> 35.75000000] [65.00000000 -> 35.75000000]

7. g OK S8 e U #R A o

©



&= 0 2 4 6 8 10 12 14

@ EREAMBB =
2 forerce Fet. ricas. 14

‘Coord System: WG5S 84
4 wm RGB Color | 8 s A,*:;a o
3

[N 'Ali,;l

1
0
100% [ Doc: 328.3K/328.3K » =

XEE, A5 GeoCrop XHI&HE 45 & HIVEREF I 7. AT LA Adobe Photoshop HJ Crop L HK#E:VIFA5 . Geographic
Inager £ ¥ Hf Crop TENHHFHYIE B R B ZIS %50 . WRER BEMBEAHE R, X Crop Tool THLHE
A0, BN TR R R O x 0 x 5%,



7. 1BH25E DEMs

Ho TR 2 — Fiofs DEM DL E ARSI J7 SU R B R (977 1%

Mo e D e FT LUK (77 S e 0 R N B SCRF Iy RE s (it DEM, SRTM 554%) b HEIT7 S Pkt (A
— A B AN E AR . MBI E A PR TTE: XRARH DEM schema HEAT B EE B B A —Fh FiE LHIET
G, MNP, EERAR N REACRBE RS, PUE R & S R R X L B A B = E AR .

7.1 ESEHIE

S\ DEM ¢4 @

24 Adobe Photoshop BLIT I FE SR N, Geographic Imager <> ZNFMIZE]. Import DEM File XHiEHES: EHEhFTH, &H
PAFEIX HLFE % — > DEM schema FIHE#E .

1. #£ Adobe Photoshop B, fE\Tutorial Data\Americas 4% F#F| Tutorial Data S 43337 JF Namu Water. dem.

2 #£ Import DEM file X}iEHER, s Create New Schema #%4H.



Open as elevation data II]
Select Schema: |Auto-stretched [v] © ./ Type |<Auto detect (DEM)> [v| | Apply to Al

DEM unit: Meter | 7| Precision: best

Maps file-specific range of elevation data to Adobe Photoshop grayscale
Tl'umethod allows for the best precision preservation and automatically generates

high-contrast maps, however the results may not be easily mosaickable or
compatible with other DEM files.

[] Don't show again

XHE, AUTIT T Edit DEM Schema XI4fHE. i% Schema Name CLZMRIGHE SCAF MR H Bh . WARYE DEM Hods i) = JE 1 B
iRt T R OB AN e ME .

Schema Name: [Namu Water

Lowest Elevation: l 1
Highest Elevation: | 1058
File DataRange: [1-> 1058] ﬁ

Vertical Unit: Meter

3. BT AR AEVEIE Y, A B i OKs

Open as elevation data
Select Schema: VM:I-> 1058 m v| Type ' <Auto detect (DEM)>

DEM unit: Metﬂ‘ edsion: 0.03 m

Maps specified range of elevations to Adobe Photoshop grayscale colorspace.
Using common data ranges allows for importing multiple files using equal schema
and therefore compatible and mosaickable. Note that elevation values outside of
the specified data range will be mapped to the min / max color values.

[] Don't show again

4. BAE, Select Schema ¥ H il &7~ T DEM H¥E (15 [FI1H .

5. 7F Import DEM file XJiHHEH., sidi Advanced ¥4



Display as transparent pixels
-32767.00

DEM elevation range
[T] Always scan the dataset
[] use signed data range

f£ Display as transparent pixels FIZEH, —-32767. 00 {H&— e LHME, RERAEE . IAMETLEME, XA K
DEM SCHEAR & —FEN . BEARE A ERMEVAEEG R, R E|NERME .

6. it Add new value $#%#H. MWdi<new value> HiA 0.

Display as transparent pixels

0.00
:-32767.00

DEM elevation range
[] always scan the dataset
[] use signed data range




7. i OK 2[4 Advanced DEM Schema Settings. i OK #%5% Import DEM file XJiHHERI ¥ B 2R EHHE SN .

B&FEFLAREBB =

Namu Water.dem

NADE3(1386)

Standard

Gray Scale | 16 Angle: 0°

Corners DEM Survey Ruler
Decimal Degrees
1,201 x 1,201 px
0.25020833 x 0.25020833 ©
0.25020833 x 0.25020833 ©
0.00020833 x 0.00020833 =

LA L3 $65 DEM (9 REVE B E UK T Adobe Photoshop K FZ B8], 7R T i K0 B . ARFEHTTH Advanced DEM
Schema HLAIBE, K LA — @WK, LXEREERERN 0.

Ub DEM L, AR 0 ARAKAR . BUAERR P /KSR IEWIRT, AT DR [ e — N R ER . H—FASF B R AR B KI5
GofE, REBIOARZKERD o £ TR H, GRS 8 D) R A R s B R B — A 2e ], 2 ad—

db
5.

8. KSR RFF AT IRIRES, I TR E BiE & 2.

W RE

Hu T #2JE 2 A1 ] DEM iﬁlmﬁﬁéﬁo AT LA PR T SRR B T 1 P B0 e P ] — A A B R =
L. 4RGN0 AT TH '\ 1) Namu Water. dem #EAT#21E

2. £ Geographic Imager M#!E, siifi Terrain Shader #%#fl.

3. s Colorization Schema &IEHERJH BN E L. EF Apply Color Map #ELiH: H BN HFIRBERIE - HifathE (S
JE— AP E) o R R RS EAE BB OR AR — R, AR ARIE SR World Fitaih e .



Terrain Shader

1058 m M

846 m

Cancel

634m

423m |

211m

Om
Colorization Schema

(®) Apply Color Map

Method:  Stretch gradient along image's DEM schema ‘(O ->1058) v | |Higher predsion (0.03 m) v
B wold v & @] |[E] |3 ™ use Continuous Color [¥] Create Single Layer
Apply Overlay Document
Available Documents: No compatible pixel size/coordinate system documents (hint: use Transform->Same As option) b
[] Apply Shaded Relief
e
Angle: 45 { ) Intensity: 30
S

Apply to selection only

Create Single Layer EIERINZAIEN], B CAGIE— NS EARE R . NaAEIXA RGNS NG EZH R
— /N ARHL A #E K] )2 . Use Continuous Color JEIRERIAMLZ AL, & REHLREN 4T A8 A 35 A B €0 1] () 0k Y 2 1 AR~ 0e T
NGB RRAELL I

4. 1F Colorization Sch At Import Color Map From File #%4H.
(Fitah B A D =AM E3H) o M Tutorial Data 30443 Hi%+% Colour Ramp Examples. grd.

5. )\ Color Map FHi5% Hi%# Elevation 3 F it Import.



Color Map: | [ NN FElevation 3

Position: 62.2%, Red: 115, Green: 83, blue: 39

Gradient Name: | Elevation 3

Color Space:  RGB Use Continuous Color
Low Elevation: lo | High Elevation: lwsa

6. M Color Ramp FHi%FK Hik$ Elevation 3, JfH siii Edit Selected Color Map #%#.

OK

Elevation: 948, Red: 79, Green: 44, blue: 28
Color Map Name: Custom: Yukon Water.dem Use Continuous Color

ovsesn o | rercesn om

Elevation (m)  Position (%)  Color
153 5

©

| AddColorStop |  DeleteColorStop | Clear Color Stops | | Reset Color Stops
Update preview image in the Terrain Shader dialog

Edit Color Map Xf i HESR 7% 1 e e B2 W 7E B tat R Lo (. RS AE AT A2 I B B MR (R 2 I AT AT &
=L U OPIVA

7.7F Color Stop 1 (FEFIFETNH) FAHZRTF AR, 375D BEdit Color Stop. Hi#, 7 color ramp I i color

chip slider.

8. fF Select Color for Color Stop XTiGHEH, # NHHIEEME Red: 204, Green: 198, Blue: 181,
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Colorization Schema

[ (1) Custom: Namu Wa ~ | | 3| 2] ¥ use continuous Color [ Create Single Layer

() Apply Overlay Document

Method: |Stretchgadentdonginage‘sl]§l'45d1ema(1-> 1058 ) v] |I-id\erpredmn(0.03m)

im

Available Documents: No compatible pixel size/coordinate system documents (hint: use Transform->Same As option)

(® Apply Color Map
"] Apply to selection only

9. 5 OK R PAIE X UEAE . YK 05 OK 2P Edit Color Map Xii&AE.



10. A Apply Shaded Relief EikHE. K F UM 40 J-K Intensity WA 35,

Apply Shaded Relief

ange: |40 () e [ | —

["] Apply to selection only

11. 5 OK.

Layers
[Pxd  :jEHOTHAY

#| opaciy: | 100% | - |

o [sowo] -

XHE, A E BT ARRCR AN AR 73X DEM Bl iR, £E Layers [HIBRHLZOREE 1546 DEM (FITS3R) HI. =i

At E%Eﬁ@tﬁo
MERI— A5, R A E N 0 B Z IR HsAE B2 51 3R T i R

12. 6@ — A E K EIS HEH % N Background. {# H Adobe Photoshop PaintBucket T E.3f H A5x4 K ZHE T8 BE
(R: 100, G: 130, B: 175),



Layers
EeTnay
INarrral :]Opa:iv-llw%l’]

lock: [ & ¢ B il [ 100% [ - |

#GI Shaded Relief Layer




8. SRR

R E Z 2% WP E

Y {RAF Geographic Imager B MM NHIS AN, BANHSBAREELSERE. AHBEHFSHEIENE: GeollFF,
BigTIFF, DEM TIFF, Geospatial PDF, ERDAS IMAGINE Raster, ECW, MrSID FI NITF. 4A4b3iix sk st gssigmt, {§H Adobe
Photoshop [¥] Save iy & RIEAFZFH G EH L SE M.

O fE Adobe Photoshop Save As XiFHEHR, GeoTIFF HfEE A TIFF (k. TIF, *. TIFF),
geospatial PDF %75 Photoshop PDF (. PDF, *.PDP). MRIEMIMAEL5 K, HoubpAKAI7E
PRAF BRI AT BB A

M5 R A7 ML Adobe Photoshop ¥, S BHENEMR—MMNESHE M. Flw, ZE— M H MBS E NG RER—
AN AEHLEE A% 2 (a0 JPEG) Y, Geographic Imager £ NILGIE—/NIMESE M (U0 World File) o BB AT CHFIN
184, ZEH Adobe Photoshop Save As fir4JF HAE Format FHi 513 B iR $E IEHHAIH o

1F Save As B, R RE AT HEA F A C Adobe options SPHHE. B0, 4FERK GeoTIFE # IS, 2>t B TIFF
Options SHEHE. 447K Photoshop PDF B}, < Hi¥{ Save Adobe PDF XfiEHE. %tF BigTIFF/DEM TIFF, ECW, DEM, USGS DEM,
ASCIT GRID F1 MrSID #&%3X, 2 HIELT EHIXAEAISFGHE .

Geographic Imager - Arcinfo ASCIl Grid Options

Data Precision

Cancel

Source Data Type: Integer

Store data as: Same as source v

@nferce square pixels

PGy 252 H K ArcInfo ASCII Grid #zCH, £HIFX S Options XTiGHE.

AR MR RGN (U0 JPEG B PNG) I, [l AR — MM SH . BN, SCfF44 74 VancouverCity. jpg
BT — D48 VancouverCity. tfw (World 2% X% 0) IS H M. EIRIFI, Geographic Tmager &3 5l
(¥ e e i R I B ROBTAH S (K25 30

LR TEHUT T % Geographic Imager MITHREJG FHARFRAZ NS 1%, Geographic Imager 4%
HIIE 25 . EXANEREY, RENSEEMEER T . AT 85 R AZE BI0ER,
A[LAER Save As 4, B —ANBICHL M E, TWAZIEE Save 4.



© 472 BigTTFF Frkith, BT 4 BEBORAR R BEAE ] JPEG BAAR R4 TURIAT (RAZAA -
%+ T RGB 8K B BigTIFF $41%, {#H JPEG AR E4F 615 5745 8 bit RGB, RGBK Y grayscale
BEREDT 4 Ao A FABAL R BigTIFF B, ZERXAEE, FoynRee 3 JPEG A E
LI (X2 SRS R

MG JPG 4R BigTIFF #52Nl), FRAZATA JPG K46 TIFR A% :UAHEL, SO R/NT RE
SHBRRARE. HEREHMBLEERZH.

© 4% Alpha Channel HEHERMAE—A DEM M HOBHRNT, 4553 A AL alpha
channels. ¥ fEfil 40 DEM, BIL 1 ASC s2 A% #F alpha channels .

O (R — AN TREIRE BEE TN USGS DEM K3, 24 RS — 12 — X, DEM 7 PR S 3
P (R AE T RER IR 1 B ) o
FHAGS ARG

JBIT Geographic Imager MMIEINZEH, & X HIALFR RG] LLFH B—4 WKT Definition File (.wkt)Bk# Esri Projection
file (prj) . MEBGETSEH %k Coordinate System 7 Export SHEHE .

— BB TR AR R G5 B2 % A (A0 world SCF. tfw) B BLAA—AN WKT Definition File (¥ Esri Projection SCfFH
RENEE . XS EE SRR RARITE S

BIER—NSH AN, A BB RA N, TTIERAFIZAIR RS, AR S — AR R G
FH—NSEXMF

A PR S () A% BRI L ARAR R G AT L@ T Geographic Imager HIMUETE A S HER— NS 0. BilETEEng
#| Export Reference Fi@iﬁ%&??%i#%iﬁﬂ%%ﬁ:

SE R SHEIMY R4

.rsf

Blue Marble Reference File

ER Mapper .ers

GeoTIFF* Ltif



. tab
MapInfo TAB File

. Ctfw, .tifw, .wld, . jgw, .pgw,
World Files .sdw, .eww, .blw, .dmw, .bpw

* MFTSCRYA TIFF fEE, R GeoTIFF . ¥ —NS% 5 H A GeoTIFF & 57— M JEHbEE 28 (8] ff) TIFF % 5% GeoTIFF
HI 5%

SHIIREWRAT DU &S — NG S5 0 S (E B NZe S A E S 053, SR)5 5 Geographic
Imager [ B ) Reference File link RIGEHHIZS %,

O mE— A HRNSEESHFEET, REMNSE LT 2RO AR E E5. A
HEMZE M, IBREAEER T . FEREFT AR ZL R — A

0.5

0.1 SHREMLEEA ( Web Tiles ) #i2

Export Web Tiles Zhfe/2Ta R T LA T 1R Hb B kA F s s Bl . B LA B9 AR e R B A2 B — AN HTIML SO A8
BT S HIETT (Web Tile Export Options) MofifHEINRH % EMELE T .

1. 7E Adobe Photoshop i, M Tutorial Data /43 B FTJF boston—east. tif.
2. fE Geographic Image , i Export Web Tiles %4l

EG S NG LN 2 81, B iEE WS 84/PseudoMercator bR &2 %t. XA Export Web Tiles IhEEF G HNiZ 1%
M Massachusetts Mainland Zone ¥ WGS 84/ Pseudo-Mercator, XFEA BEIZS.

3. Ml A% H4k 42 S (Transform the image and proceed with the export) .



Transformation is required

The current document must be in the standard north-up Pseudo-Mercator coordinate system to be exported
to web tiles,

< Transform the image and proceed with the export
Geographic Imager wil temporarily transform the image to the required coordinate

system and then export it to the web tiles. Note that Geographic Imager wil apply the
last used transformation settings for this operation.

oy hon -

4. 7f Export Document to Web Tiles XiHHEHR., M Map Provider TFHi%13 Hi%$ Google Maps.

5. fF Name #2 5, HEy4 N Boston.

6. X} T Folder, giifi Browse, 7E Tutorial Data T3 HLEIH— 4N WebTiles HISCHEF .

Destination:
Map Provider: | [ Google Maps v

Name: |Boston

& DatalTutorial Data\WebTiles | | Browse...
« Folder is valid.

Zoomlevel | Options | Google Maps |

Document pixel size: 1.875 x 1.875 meters
i Level 10 - 153 metersjpixel v |
Level 1 - 78272 meters/pixel

[] set maximum zoom

7. 7E Zoom Level &I H, ¥ Maximum zoom i Level 17 — 1.19 meters/pixel 3 HA54a Mk MG HCHN 17.



Zoom Level | Options I Google Maps I
Document pixel size: 1.875 x 1.875 meters

Maximum zoom: [Level 17 - 1,19 meters/pixel v |
Minimum zoom: Level 1 - 78272 meters/pixel

Zoom levels: [] set maximum zoom
Total tiles: 90

MILERE T A 90 ML EINE. f/NEUE 2 Level 1 — 78272 meters/pixel, A bR —AN/NELHIRE.

8. sl Options &£, M Image format F+i%1Z% B %+ PNG I HoKf Compression B 0.

Options | Google Maps

Image format: Compression:
Colour mode:

Image resampling: IAutmtaﬁc v |

ot ol

Compression {55 0 Al DABE{# 3 H m R E MR . BT LK Google Maps BT 1% B ik AR IN (L A] LIS — P X s &
SN ZHL B A AR, ) o

9. iy Advanced 1% . E3F—4 World # M=% 01k, K5 St 0K

FEAN AN, (R W AR e 7 X e R BRI IS, ARSI E) .
10. 5 OK FF4f 5 H AL HE,
11, 52 MG G S A S, KBS E S k.



I 4 L= Boston - oIl
Home  Share  View - @
C) w 4 |} « User Guide, Tutorial & Data » Tutorial Data » WebTiles » Boston v| ¢ | | Search Boston p

[ » % Favorites |
| ] E | ] E |
@ Onedrive E E : : : :
i 1l f | f J 1l E J
I This PG 71 ) z 7 z 6
€ Network i i | I i
z I z i I |
|l il 11! 1l 1l bl
z7 78 79 710 1 712
] B | ] ] E
1 F il i 1l
11! 1l |l |l 11! _
713 714 15 716 77 Boston.html
18items  State: 3 Shared ;zz@

FEFHSCIERTS, AEIE 7L SCER (Z1 2 Z217) o IXEESCPJe BRI 48 B 1R PNG S21R, AUR TIERE I 17 N4
TR o 1T HLAE ST B 45 ERAEAS B R AR SGIR IR TRW 2225 301

12. X7 Boston. html 7 M 253 %1 28 T E .

r

Bu € > Jonument (1
v

e
7 1S ueipuasy

BostofiNational %"
Historical Park ™

\ ]\
Sand:&2rqvel
ers

Basing
== ‘J‘

s Rivi 2

O

Nortry Slationm
Commuter Rail*~

North Station[Z)@
X %, Piers Park
% % M,
) The Paul 3 Port of Boston
Haymarket ®

dge St Bowdoin@® Union Oyster House

Faneuil Hall Marketplace

_ & \
e Aquarium @

chusetts~=

5]

State Street@® New England Aquarium (= Map data ©2015 Google | 200 m L———1 | Termsof Use | Reportamap emor | <



1% Boston. html XA & T XML GZHE B A M Geographic Imager S AMIFTH EIE) .

9.2 S (&% PDF Maps i

Export to PDF Maps TiREEH8 4 i — AT LLE#: 4% 3] PDF Maps Store—PDF HuEIRGME (B — 23S 7E 10S. Android 1
Windows F-HL_EfY PDF Maps app M AFEF W EBHIRE MG BGMEA. XA shis LA EREEATE PDF Maps Store
LHJ Prepare for Review Hf. A%, #EFHEA —/ PDF Maps )& AL K P .

1. £ Adobe Photoshop H, M Tutorial Data 43¢ H$TH boston—east. tif.

2. fE File S5 H, %) Export > Export to PDF Maps.

Export to PDF Maps

I\ Folder: {aphic Imager\AvenzePDF\| | Bromse... | [ oK
« Folder is valid. G
Convert to indexed color mode (recommended)

Image resampling: jAuhomatic v |
Launch upload dialog after creating files
Open export directory after processing

XFEHLHIL T Export to PDF Maps XEHE. 0] LAFE & — AN RIS H SO 3 BAE X BN HHT R E . AR B A g o,
MBI G R R BiEM, S 5ERUE s E4E3] PDF Maps (Upload to PDF Maps) XIiEAE, I HFTFF 0%
EE NN T B L

3. fiih oK.

©



Home Share View

@ @ v 1 |l <« AvenzaPDF » boston-east v ¢ Search boston-east

¢ Favorites 52 boston-east.csv
— a Microsoft Excel Comma Separate...

88 bytes

#& OneDrive

i: boston-east.zip
18 This PC _§b

boston-east_95px.jpg
€ Network JPEG image

32.2KB

boston-east_233px.jpg

JPEG image

105KB

boston-east_preview.jpg

JPEG image

264 KB

ZS R ER T XA E A, 24 FA£3] PDF Maps Store I, O3 BRGSO R B E N . MIEE %4 i
iy, R Z1P .

Sitems  1item selected 88 bytes

4 HB Upload to PDF Maps XfifHE. ZAR LAEME, EFHEEFEH S PDF Maps Store LN K 5 .
4. 7f Upload to PDF Maps XJ1EHE B, i Login #%4H.

5. B TE IR S MR AN D, SRS mdT Logine

@ |username @avenza.com
d: Ioooooooo

[] show password

6. 7f Upload to PDF Maps XififEH, 55 Load maps from folder #%#f.

7. #f Load From Folder XJiGHEH, #H£SHfFk (FEARZ B, J&\Geographic Imager\AvenzaPDF\boston—east), #RJ5 i
5 0K,



,M Folder: kl'etm\GeograpﬁcImagerV\vmzaPDF\boshon-east] | Browse... l I

« Folder is valid. .:

XA A ME] T Upload to PDF Maps XFiRAERIZAE B, I HA KA CHIMEGE R

Logged n as @avenza.com G0 to PDF Maps Store

Select multiple records in 2 fizld to batch edit. Select entire rows to edit all values or to delete

Uploaded  File Name Title Description Languages Publisher Published Date Pricing Search Tags Primary Category Countries
1 Q boston-east.zip boston-east

=) [[] Remove files after upload

8. M i Description k. 7E Edit “Description” X iEHER] Description CAKE B AR E S, AR5 M i 0K

* | An orthophoto of downtown Boston.

IXEE, 58T Description, ZMLEZERLA T W% SO R,
9. i Edit A1l #%4H.

XA~ Edit Maps Xﬂ‘iﬁ'@E’ﬁﬁﬂ‘]&ﬁ%ﬁ?ﬁﬁﬁﬁﬁﬁi&%ﬁﬁﬁo WA A, ST DU AT S R RS Sh B AT — A
R — M



toftfb M [ ok ]

!C:\LJsers\Nﬂcel.\AppDatalocal\Temp\GeograpHcIrnager\AvenzaPDF\bosmn-east\boshon-east.zb | l Browse... I l Cancel I
«” Filename is valid.

| boston-east

An orthophoto of downtown Boston.

Available:

Afrikaans
Arabic m
Chinese (Cantonese) [I]

Chinese (Mandarin)

Information about when the map was published (e.g. "2010%, "Dec 20119
Pricing: [—Free -
Search Tags: [
Space separated list of keywords (e.g. "muskoka ontario fishing hiking™)
Primary Category: [Aaornuhd - ]
Countries: Available: Selected:

Afghanistan
Africa [ﬂ
Aland El

Albania

10, SERON e EIR g, WREpR, SR s 0K,

toffb M [ ok ]

| C:\Users \MikeL \AppData L ocal \Temp\Geographic Imager \AvenzaPDF \boston-sast\boston-east.zip | | o | [ cancel |
«” Filename is valid.

| boston-east

An orthophoto of downtown Boston.

Selected:
English

4 [»]
Chinese (Cantonese) E
Chinese (Mandarin)

lAvenza

| april 2015

Information about when the map was published (e.g. "2010%, "Dec 20117
Pricing: [~Free -
Search Tags: Ibostnn, massachusetts

Space separated list of keywords (e.g. "muskoka ontario fishing hiking™)
Primary Category: |Imagery -/
Countries: Available: Selected:

Africa
Aland

Afghanistan E United States of America
Albania E




FEIK HL G B L [ 034 (5 S BRAE PDF Maps Store P W3k 22— FEAT . S0RT DAAEIX HL g A0 T DAAEIE B il . AN

ERE, MRS SR HERIF H e B, KP4 BELE PDF Maps Store HURZE 5 AR B AIBA] .

Upload to PDF Maps
Logged in | Logout | Go to PDF Maps Store | Upload
Select multple records i & Bk to baich adk, Select ent rows 1o ad =l vakues or o deie Close
Uploaded  File Name Title Description

Languages Publisher Published Date Pricing

1 & boston-eastzip boston-east An orthophoto of downtown Boston. English

Search Tags Primary Category Countries
Avenza  April 2015 - Free - boston, massachusett... Imagery United States of America

o] [E] [B] @ [ Remove fles after upload

Edit Selected... Edit All...

11. Ads Upload #%#.

Select multiple records in 2 field to batch edit. Select entin

Uploaded  File Name Title

1 f_, boston-east.zip boston-east

Uploaded 51| B EIbR AR (b R iR M B C 28 B AR T

12. 7£ Upload to PDF Maps X iEHE B fiili Go to PDF Maps Store HE:EN 3 /& 7E — A~ M4 Ui % 4T T
https://mapstore. avenza. com/vendor/login/. FHHSHIIK &St REE BIG EAL LA .

©


https://mapstore.avenza.com/vendor/login/

avenza.com
Avenza Map Store (@] ¥ | Locout

Earnings Notifications ! Add a New Map

| Select an action.. v |Go| Search
I Title State Updated | D load
L [Search|
[J boston-east Prepare 2015-04-14 0
Filter

& Remember to submit your maps to Avenza for review after you have finished preparing them.

A purchased map may be downloaded several times by a user (for example, to load the map on different

For Sal
devices). Sales numbers for maps can be found on the "Earnings” tab. g

On Hold, Ready for Sale
Download PDF Maps marketing materials (logos and brochures) here.

In Review

Prepare For Review

Copyright ® 2015, Avenza Systems Inc.  Legal Agreement  Contact Support  Help

e —— e — e - -

fE Maps JUH, #aESEC AL, R LA EUE Prepare IR H, BEWRE ZHEBEMRSEZ. DM T HTH
it IR R A5 B, AT RL AL T # A%, SR R T H RS, BERREH AR T # i H (In Review) . PDF
Maps 1B\ 2> EAH A0 X Letth FIREAT 8 A%, UGB G, MACEMEISE M (On Hold) BAFIEL, HE&HIH (Ready for
Sale) IR#A. IXHF, #mhal LUK ZH B B L For Sale R4, 7E PDF Maps Store HUA4HE T,



10. Geographic Imager BaliitabIR2LFE

Adobe Photoshop HI#E{E (Actions) FIIA (scripts) #E Geographic Imager B EFrHI, JFHWLMEH Javascript f
actions ({HSE, HHI Visual Basic 1 Applescript AT LB B shib AL HE

Actions Al scripts AJ LMEE B S SKILEZIL, AR I FEIESIRME THRKIER] . WA ERIEA —NFAL, OB
WA SHFE TR, X DU T Y TS R Yok . AW OREZ AR . 5 — MEA R, A E R —
ST E RS AR, BT DME R AT AR B AR . 1 T IIASR ] Javascript KSH), FrileTRERS 1 & H A I HAEAIF
THEHLETAE, TRiEA R AR RS LT,

JAT] LA B SRR %S (W0 TextEdit Fl Notepad) HEBMYiE. HARKFIN T, BANZEH Adobe Photoshop F2LH
Adobe ExtendScript Toolkit REIEFIZEIT. XN HEFRME TREZFRTE, FETFaIEMA. thar B Adobe
Photoshop %35 ) ScriptListener ffifEaIEHIA.

BES IO R —AHECE R, HFAER—/ M7, Adobe Photoshop CS6 /CC 2014 A EEHIAE 5 319, BT MHE

Z{5 K., EVin Adobe Photoshop BIASTE S M %G: http://www. adobe. com/devnet/photoshop/ scripting. html.

R/ AR DI e

TEFRAE B AR B 9 Adobe Photoshop ZIREWS IR IES % /E 8. &, HT Adobe Photoshop API HIFR#I, A —LLThfe
AR

XFFHITHEE

® ExtendScript Toolkit

° Run script using File > Scripts > Browse

® Run script by double-clicking script

® Run script by drag-and-drop into Adobe Photoshop

® Run action using@ Panel

[ Image Processor

® C(Create Droplet

® Actions that run a script or another action

® File > Automate > Batch, where the Source drop—down list is set as Folder or Open Files.
® File > Automate > Batch, where the Destination drop—down list is set as None or Save and Close.
() Scripts that run another script or action

(] Actions that run a script or action that run another script or action

® Scripts that run a script or action that run another script or action


http://www.adobe.com/devnet/photoshop/scripting.html
http://www.adobe.com/devnet/photoshop/scripting.html

PCFrIRITIRE

Adobe Photoshop closed when using automate tools
Insert menu item from Action panel

Script Events Manager

File > Automate > Batch, where the Destination drop—down list is set as Folder.

Specifying new folder names and new file names are unsupported.

File > Automate > Batch, where the Source drop—down list is set as Advanced Import. The action is not
completed because Advanced Import parameters have to be set manually
10.1 BEEIREFIBF
i ScriptListener i IEEVE S HIAS 2 TCVEAE M 2] Geographic Imager THIFRIZHL . BEBRIE TR H11
DA EBUAKS, PRI File > Automate menu 5/ LAF Uiig:
Geographic Imager: Quick Rectify AT PO IE— SR .
Geographic Imager: Channel Management HFEEH G B BN .
?%mmmlmynEmwt%Mﬁmm ST LR g0 Al 22 I
ystem
Geographic Im: : Export Reference File MEEX—5 G S HESE R ER.
C
Geographic Imager: GeoCrop T BN — S B AT U A B A
Geographic Imager: Georeference MR TR S ENEA .
Geographic Imager: Mosaic AT RS BRI A
W EEQE— DEM TIFF, USGS DEM, ECW, ERDAS
Geographic Imager: Quick Save To Format IMAGINE Raster, geospatial PDF, GeoTIFF, MrSID i
NITF HHAEH




oRE &R Geographic Imager MR

Geographic Imager: Show Panel
geographic Imager: Specify Coordinate S R A R G

ystem
Geographic Imager: Specify DEM Schema M EFON— AR IR — P DEM =78 )7 EFHE A .
I(:Iitl)iraphic Imager: Specify Reference R B
Geographic Imager: Terrain Shader YR BN — RGN A LB T A
Geographic Imager: Tiling M T BT —F G AT A IR S A .
Geographic Imager: Transform YR B AT AR RGBT A

MEFIRAESUHARS, TTLAM File > Export menu ff F LA T DiE:

Export to PDF Maps 75 S ] 6 5 H B PDF Maps B8H .
Export to Web Tiles MRS L LA I .

10.2 EFHHiI]ZIS;E@@eogra phic Imager INgEAGHEAL IR

Adobe Photoshop EEA IR AIERIA . 55— FhJ7VET EX Adobe Photoshop HAFFHEBIAIILAN) JavaScript FufEsry
PR . SRR A, J7 (I GeographicImager. jsxinc SCHFBEARHLRTHEERI AT o 58 7 22 A ] Adobe
ScriptListener Hfiff (L3 T HI P HATHIERAE) REIEMIA, R85 RA7 R — MERPAT I ST A o 72 VPO Al —
ANIAT— RIUES AR RIS, XA E 31 AE B4R 2 /DA St TS 4Edr, RO 4 T BT GRS S50 (s ki
1) o [FIRARMES IS, A EE R AE A1 Adobe Photoshop B Geographic Tmager %K 2% B HIH 78 T 18 Y
Adobe Photoshop il & E#iHH T Adobe Photoshop K IIAE. WIREESFAEH Script Listener il M4, &l

AEARAF Y5 E Geographiclmager. jsxinc 3 T {45 Geographic Imager v 2HIEASEL.



© ST Adobe Photoshop Ihfig, W% Adobe HIATCHY. Adobe #3E (http://
forums. adobe. com) DA} ZE =75 Wyl RIECA A 115 B -

Geographic Imager %3 T — M4 NFEFIEIA (Sample Scripts) MIH%, fE:

Windows 7/8 (32-bit and 64-bit)

C:\Users\Public\Documents\Avenza\Geographic Imager\Help and Tutorial Data \Tutorial Data\Sample Scripts
Mac

/Applications/Avenza/Geographic Imager/Geographic Imager Plug—in/Help and Tutorial Data/Tutorial Data/Sample

Scripts

XA Sample Scripts AFJEFE:

AL T X T A Geographic Imager JHIAS D) RERIFEG] 1115
ScriptExamples. jsx

T o

ScriptBatchProcessingExample. jsx | W35 7 — /AN HEACER AFEBI A

3D Overlay Script. jsx A s A T EE &A% 1K 3D DEM [ —ANMEIAR .
Mt Olympus. jsx IR Geographic Imager #FE—ite{#iH .
Batch export to PDF Maps. jsx HT¥% 240455 PDF #h &,

~ BEANERSCIESE, StartupRegistrationScripts Al IncludeScripts, HLUHILHEIIA i 5)
Geographic Imager #HAERIBIZARIE F A . XL MR I ABAGEE dr 4B MR, 750
Geographic Imager Y§TCVASCHF. WIREArAECE MR T, wT Lo s el J5 ok i1 48 PR el = 22
X Geographic Imager FIKE .

© f% Geographic Imager MHiFHE CHUEAE—ANIEFHAHICRY) HIMIAAL Adobe Photoshop 4
V¥ B R E N “showerrors—only” #z.


http://forums.adobe.com/
http://forums.adobe.com/
http://forums.adobe.com/
http://forums.adobe.com/

© FEHATRR 7 FEHG T AS I3 A2 B L B Geographic Tmager SHEHE, 7% i AEH 2 4 B
N EABATAOEMET . RA N T HA S GE IR — MRS TR R
FHERAESEI) oS WA ML AR T, . T B IO O A PR R . X
AT LU A% Don” ¢ show again” ETRMEHM .

© 1T Adobe Photoshop APT R, 4 FHRIA BR5-42 14T F— N Hu B2 6] PDF SCRRY,
Geographic Imager ANEEM'E B H BN SHE R

© 47E— B L EF DEM schema ZFRIT, %4 FREARSHE Unicode S5 .

(@) AR DEM schema F& TBIEIE R LE Adobe ScriptListener Bifdi LG I A HiC T/ . AR
DEM schema #3455 T4 H 2 Ab AT A ).





